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CHAPTER ONE

STALLING
OVATERM
OFTWARE

nwz<-

B In this chapter, you’'ll learn how to install NovaTerm, the client software for the
pe NovaServer information server.

SYSTEM REQUIREMENTS

NovaTerm is available in both Macintosh® (MacOS™) and
Windows® versions.

NovaTerm for Macintosh requires:

¢ A 680x0 Macintosh (Mac Plus and newer), Power Macintosh,
or comparable MacOS compatible computer with at least 4
megabytes of memory (RAM) installed.

¢ 2.5 megabytes of available memory (RAM).

* Macintosh system software version 6.0.5 or later.

NovaTerm for Windows requires:

* A 386 PC with at least 4 megabytes of memory (RAM).

Faster processors and additional memory are strongly
recommended, and may be required for some systems.

e Windows 3.1, Windows NT, or Windows 95.
Windows 3.1 users require WIN32S. This file is included in the
NovaTerm for Windows installer.

NovaTerm (for Macintosh or Windows) also requires:

* 3 megabytes of hard disk space.

Connecting to some services, or to more than one service, may
require additional disk space. More disk space is also
recommended if you plan to use the NovaTerm web browser.



INSTALLING NOVATERM

The following steps describe how to install the Macintosh and
Windows versions of NovaTerm. If you have a pre-configured
service file for a NovaServer service, follow the steps for installing
service files after installing NovaTerm on your computer.

NOVATERM FOR MACINTOSH

The NovaTerm for Macintosh installer is titled
“NovaTerm 4.0.sea”.

To install NovaTerm on a Macintosh:

I Double-click the NovaTerm 4.0.sea icon to open it.

MovaTerm 4.0 503
2 Click Continue.

3 Read the license agreement. If you agree to its terms, click Continue.

Install NovraTerm 4.0

This will install NovaTerm 4.0 and the
NovaTerm resources file.

Installation requires: 2381K

4 C

You are running on a 68010 machine. Some
applications to be installed can be run on both
PowerPC and 68040 machines.

Do you want to install the larger Universal
applications or the smaller specific ones?

[ 680x0 | [ PowerPC | ..
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The installer tells you whether you are running on a 680x0 Macintosh or
a Power Macintosh. You may install a version of NovaTerm that runs on
either type of computer, or install a smaller version that runs only on your
type of Macintosh.

5 Click Universal to install a version that works on both types of
Macintosh computers, or click the appropriate button to install the
smaller version that is specific to your Macintosh.

|3 Telecom ¥ | = Hard Disk %
& Napaterm 4.4.980 £ ipnt |

Install software into folder:
NouaTerm 4.0 Folder J Install

VH

6 You can use the installation dialog to select a location for NovaTerm or
change the name of the NovaTerm folder.

If you do not make any changes, a folder titled “NovaTerm 4.0 Folder” is
placed in the same location as the NovaTerm 4.0.sea file. NovaTerm 4.0
and the NovaTerm Resources file are installed in this folder. In order for
NovaTerm to work properly, NovaTerm Resources must remain in the

same folder as NovaTerm 4.0.

7 Once the installation is complete, click Quit to leave the installer or
click Continue and repeat steps 4 through 7 to install NovaTerm in
another location.

NOVATERM FOR WINDOWS

The NovaTerm for Windows installation files are available on two
floppy disks or, for downloading, in an archive titled
“NTINSTAL.EXE”.

Note: When you run the installer, it places a file titled “NOVATERM.CFG"
in the same directory as the NOVATERM.EXE file. In order for NovaTerm to
work properly, NOVATERM.CFG must remain in the same directory as
NOVATERM.EXE.

To install NovaTerm under Windows:

I If you are installing NovaTerm from the NovaTerm 4.0 floppy disks
(NTDiskl and NTDisk2):

a Insert NTDiskl in the floppy disk drive.

Chapter [: Installing the NovaTerm Client Software 3



2

b  Within the Windows Program Manager, choose Run... from the
File menu.

¢ Type the pathname for the NovaTerm installer, and click OK.

The pathname should be either ANSETUP or B\SETUP, depending
on the floppy drive you used.

d Skip to step 3.

If you downloaded the NovaTerm installer (NTINSTAL.EXE) to your
hard disk drive:

a Create a new directory for NovaTerm.

You can do this by opening the File Manager that is usually in the
Main group of the Program Manager. Select the directory in which
you want to create the NovaTerm directory, then choose Create
Directory... from the File menu. Type NovaTerm and click OK.

b Move the NTINSTAL.EXE file into the new NovaTerm directory.

To do this within the File Manager, drag the file into the directory
and click Yes.

¢ Open NTINSTAL.EXE by double-clicking its name in the File
Manager.

The installation files are decompressed.

d Open the SETUP.EXE file that should now be in the new
NovaTerm directory by double-clicking its name in the File
Manager.

Click Continue.

The installer examines your system to determine which version of
Windows you are running. If the installer determines that you are running
Windows 3.1 and that you do not already have WIN32S installed, it will
install WIN32S later in the installation process.

Type the pathname for the directory into which you want to install
NovaTerm, and click OK.

Usually, the destination defaults to the main directory of your hard disk. If
you already have a copy of NovaTerm installed, the destination defaults to
that copy's directory (if you choose this destination the copy of
NovaTerm that you are installing will replace the original copy). If the
default destination is acceptable, you may simply click OK.

If you are running Windows 3.1 without WIN32S, you need to install
WIN32S. To do so, skip to step 6.

If you do not need to install WIN32S, the installer copies the NovaTerm-
files onto your disk and creates a Program Manager group called
NovaTerm that contains NovaTerm 4.0. Click OK to exit the installer and
finish the installation process. (Skip the remaining steps.)

NovaTerm 4.0 User Guide
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If you are installing NovaTerm from floppy disks, insert NTDisk2 when
the installer asks for it, and click OK. Then, when the installer asks,
insert NTDiskl| again and click OK.

The installer copies the NovaTerm files onto your disk and creates a
Program Manager group called NovaTerm that contains NovaTerm 4.0.
After installing the NovaTerm files, the installer begins the WIN32S
installation.

Click Continue.

The installer shows the destination directory for the WIN32S installation.
You cannot change this directory.

Click Continue.

When the installation is complete, click OK.

The WIN32S installer also gives you the option to install a game called
Freecell that may help you test to make sure that the WIN32S installation
was successful.

To install Freecell, click Continue and skip to step | I. If you do not
want to install Freecell, click Exit and skip the remaining steps.

The installer restarts Windows to complete the installation.

Type the pathname for the directory into which you want to install
Freecell, and click Continue.

Click OK.

To complete the installation, click Continue.

The installer restarts Windows to complete the installation.

INSTALLING PRE-CONFIGURED
SERVICE FILES

NovaTerm uses a service file for each NovaServer that you connect
to. The service file tells NovaTerm how to connect to the service
and stores the service’s custom graphics and sounds. Every time that
you use NovaTerm to connect to a service, the service file that you
use is automatically updated with the service’s latest custom
graphics and sounds.

NovaTerm Service files are represented by this icon.

Chapter I: Installing the NovaTerm Client Software 5



Some services distribute pre-configured service files that already
have the service’s access number and network address. These files
also contain the service’s custom graphics and sounds so NovaTerm
does not spend time updating the file when you first connect. To use
a pre-configured service file, you must place it in the NovaTerm
Services folder that is created the first time you open NovaTerm.

To install a pre-configured service file:

Open NovaTerm 4.0 by double-clicking its icon in the NovaTerm 4.0
Folder or the NovaTerm Program Manager group.

E[ === NovaTerm 4.0 Folder ==
112.5 MB in disk 5.9 MB available
P

MovaTerm 4.0 MowvaTerm Resources

Receives

BT — §f§>@3

NovaTerm creates three new folders or sub-directories titled “Services,”
"Receives,” and “Outgoing Mail" (or “Outgoing” on PCs). Services holds
all of your NovaServer service files and must remain in the same folder as
NovaTerm. (You'll learn about Outgoing Mail in Chapter 5 and about
Receives in Chapter 6.)

Move the service file or files into the Services folder or sub-directory
within the NovaTerm 4.0 folder or group.

EDE Services EEEI
2 items 1125 MBin disk 5.5 MEB available

Untitled Service MNowvaCentral

Connect

Bisconnect D

The NovaTerm Services menu
lists each service file in the
Service folder, and places a

check next to the currently Create...
selected service. Setup... #E
NovaCentral

v Untitled Service

NovaTerm 4.0 User Guide



B [n this chapter, you’ll learn how to configure NovaTerm, connect to
NovaServer, and create a new account.

SELECTING A SERVICE

You need a service file for each NovaServer system that you
connect to. The service file tells NovaTerm how to connect to the
service and stores the service’s custom graphics and sounds.

CREATING A SERVICE FILE

Many services distribute pre-configured service files, but if you do
not have a service file for a given service, you can create one.

To create a new service file:

!
2

Double-click the NovaTerm icon to open it.

Choose Create... from the Services menu.

Type a name for the new service, and click OK.

The connection settings window opens. Configure these settings as
described below in “Configuring the Connection Settings.”

When you connect to the service, NovaTerm will automatically update
this service file with the system'’s custom graphics and sounds.



USING A PRE-CONFIGURED SERVICE FILE

If you already have one or more pre-configured service files, you
must select which service you want to connect to.

To select a pre-configured service file:

Make sure the service file is located inside the Services folder within
the NovaTerm folder.

Double-click the NovaTerm icon to open it.

Untltled Seruu:e

NOVATER

lIENT S OFTWABRE™

Version 4.0

Passcvord:

[ Setup | [ Help | [ quit }

The name of the currently selected service appears in the window title.

Select the service to which you want to connect or that you want to
configure by choosing its name from the Services menu.

Connect

Bisconnect 0

The name of the selected service appears in
Create... the window title and is checked in the
Setup... ®E Services menu.

NovaCentral |
v Untitled Servic
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CONFIGURING THE
CONNECTION SETTINGS

Once you select a service file, you must tell NovaTerm how to
connect to the service. These connection settings are unique to each
service file, so you must configure them each time you install or
create a new service.

There are four ways to connect to a NovaServer system:
e Using a modem and a phone line;

¢ Using TCP/IP through a local area network (LAN) or wide
area network (WAN), including the Internet;

e Using AppleTalk through an AppleTalk network; and

* Locally, if you are running NovaTerm on the same Macintosh
as the NovaServer system you want to connect to.

Note: If you are connecting through a TCP/IP or AppleTalk network, you
must be connected to the same network as the service. Also, not all
NovaServer systems support all four connection types, and some services
require special account privileges for certain connection types. Contact the
service administrator for information on supported connection types.

To configure the connection settings:

I If the connection settings window is not yet open, click Setup in the
NovaTerm main window or choose Setup... from the Services menu.

Untitled Service

E Save Service Password |:| Connect Through Provider

Screen Name : | IR L AR

Connect To Service: I:I fz a Mew User

Access Number : [1714-379-9004

Chapter 2: Connecting to NovaServer s



Choose the way that you want to connect to the service from the
Connection Type pop-up menu.

Type your “screen name” on the service in the Screen Name field.

Your screen name is the name you use on the service. If you do not
already have an account on the service, do not enter anything in this field.
Instead, click the As a New User box to check it.

Tip: Many services let you try a guest account before creating your own
account on the service. To connect as a guest on most services, type
“guest” in the Screen Name field and in the Password field in the
NovaTerm opening window.

Enter the service’s connection information, as instructed by the service
administrator and as explained below. The information that you need to
enter will depend on the setting in the Connection Type pop-up menu.

Connection information, such as the service phone number or network
address, tells NovaTerm how to reach the service. If you are using a pre-
configured service file, this information should already be complete.

If you selected Modem as the connection type:

Click in the Access Number field and type the service's phone number. If
you are using a pre-configured service file, you may need to add or
remove the area code, as appropriate.

In some cases, the service may instruct you to connect through another
server, or “provider.” In this case, click the Connect Through Provider box
to check it. Then, enter the Provider Account and Provider Password in
the appropriate fields. If the service instructs you to enter something in
the Connect to Service field, do so. Otherwise, leave this field blank.

After you complete the connection settings in this section, you should
also configure the modem settings, as described in the next section.

Note: NovaTerm does not require information about the type of
modem you have because its auto-configuration feature can successfully
initialize almost all modems. If your modem is having difficulty connecting,
however, you may use the Custom Modem Init feature described in
"Configuring Modem Settings” below.

If you selected TCP/IP as the connection type:

Click in the Net Address field and type the service's domain name or IP
address. Do not enter anything in the Connect to Service field.

Note: To connect to NovaServer over TCP/IP, your computer must be
connected to a TCP/IP network. For Macintosh users, this requires
MacTCP version 2.0.6. For PC users, it requires WINSOCK.

NovaTerm 4.0 User Guide



If you selected AppleTalk as the connection type:

Choose the zone in which the service is located from the Zone Name
pop-up menu. If there is more than one NovaServer in that zone, click in
the Connect to Service field and type the name of the service. (This is the
service name provided by the service administrator, which may be different
than the name of the service file that appears in the Services menu.)

If you selected Local as the connection type, you do not need to enter
any other information.

5 If you prefer to have your password automatically saved, rather than
entering it each time you connect, click the Save Service Password box
to check it.

Keep in mind that while saving your password may be convenient, it will
also allow anyone with access to your computer to connect to your
account without needing to know the password.

6 Click Save.

CONFIGURING MODEM SETTINGS

If you are using a modem to connect to the service, you must also
configure the modem settings. Unlike the connection settings, modem
settings are not specific to a particular service and only need to be
set once.

To configure the modem settings:

I Choose Modem Settings... from the File menu.

Modem Settings

Internal Modem

D For outside Tine dial: IQJ ]
E] If busy redial after: EI Secs,

[] custorn Modern Init: |

2 Choose the port that your modem is connected to from the Port pop-
up menu.

3 You may adjust or turn off your modem’s dialing volume by choosing
the desired setting from the Volume pop-up menu.

Not all modems acknowledge this setting.

Chapter 2: Connecting to NovaServer I



4 If you are using a phone that requires you to dial a prefix to get an
outside line, click the For Outside Line Dial box to check it and type
the prefix in the adjacent field.

If you must wait for a brief time after dialing the prefix to get the outside
line, include a comma after the prefix, as in the picture above. If the delay
is longer, you may need to add more than one comma.

This feature can also be used to include a long distance code or prefix
that disables call waiting.

5 If you want NovaTerm to redial automatically if the phone number is
busy, click the If Busy Redial After box to check it and type the
number of seconds that NovaTerm should wait before trying again.

If you select this option, you can stop NovaTerm from redialing by clicking
Cancel in the window that appears while NovaTerm is dialing.

6 NovaTerm can auto-configure most modems, so do not check
Custom Modem Init unless your modem fails to connect properly.

If your modem is unable to connect properly, see the troubleshooting
suggestions in “Getting Connected” in the Appendix.

If you are already familiar with modem initialization strings, and want to
enter one for your modem, click Custom Modem Init to check it. Type
the string in the adjacent field, omitting the initial “AT" (NovaTerm adds
this command automatically.)

CONNECTING TO A SERVICE
FOR THE FIRST TIME

When you connect to a service for the first time, you must create a
new account. If you have not already selected and configured a
service file for the service that you want to connect to, follow the
instructions for doing so earlier in this chapter.

Tip: Remember—many services let you try a guest account before creating
your own account on the service. To connect as a guest on most services,

type “guest” in both the Screen Name and Password fields, as described in

“Configuring the Connection Settings" above. If you connect as a guest, you
will not be asked to enter personal information.

To create a new account:

I When you configured the service, you should have checked the
As a New User box.

If you did not check this box, see “Configuring the Connection Settings'
above.

|2 NovaTerm 4.0 User Guide



2 Click Connect in the NovaTerm opening window.

NovaTerm connects to the service and lets you set up a new account.

e New User

Screen Name :

First Mame : I Last: |

Company :

Street Address:

ey City :

Fhone : J Country :|

— Cormnputer Type:

LAt e e

|
|
I
|
r
State: | | zipCode:|
I
=

I Password: |

l Disconnect ] Register New

3 Type a screen name for yourself in the Screen Name field.

A screen name is the name you go by on a particular service. Make sure
that you choose a name that you are comfortable using because it will be
your permanent screen name, as well as the first part of your Intermet e-
mail address. Some services require that you use your real name, but
others allow you to use a nickname or pseudonym.

— 4 Enter your real name, address, and other requested information in the
appropriate fields.

You must make an entry in every field to create a new account.

. 5 Type the password you want to use to connect to the service in the
Password field.

As you type your password, dots appear instead of characters so no one
else can see what you type. Once you create the account, you can usually
e change this password, as described in "“Changing your password" in
Chapter 3.

6 Click Register New.

— A new account is created with the screen name and password that you
entered. NovaTerm automatically turns off the new user setting and
e enters your new screen name in the connection settings.

Some services may ask additional questions once you connect or limit
your access privileges until they verify your personal information and
validate your account.

The next chapter will help you explore the service.

Chapter 2: Connecting to NovaServer 13



CONNECTING ONCE YOU
HAVE AN ACCOUNT

Once you set up a service file and create an account, connecting to
the service is easy.

To connect to a service:

I Make sure that the service selected in the Services menu is the one to
which you want to connect.

The name of the currently selected service appears in the title of the
NovaTerm opening window and is checked in the Services menu.

2 Type your password in the NovaTerm opening window.

As you type your password, dots appear instead of characters so no one
else can see what you type. If you check the option to save your
password in the connection settings, your password will already appear in
the window, represented by dots.

3 Click Connect.

NovaTerm connects to the service.

DISCONNECTING

Most services limit the time you are allowed to connect to it in a
given day. So, when you are finished using a service, disconnect
from it promptly.

To disconnect from the service:
¢ Choose Disconnect from the Services menu.
Or,

¢  Click the Disconnect button, if one is available.

If you have finished using NovaTerm, you may also quit it.

To quit NovaTerm:

e Choose Quit or Exit from the File menu.

NovaTerm 4.0 User Guide
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EXPLORING A SERVIC

In this chapter, you’ll learn the NovaTerm basics and you'll be introduced to

the different types of areas on NovaServer services. Once you know these
basics, you’ll be able to explore new services on your own.

GETTING TO KNOW A SERVICE

NovaServer from ResNova is a powerful and flexible information
server that lets its users create unique online services. When you
connect to NovaServer using the NovaTerm client software, you'll
discover an easy to use graphical interface that lets you access a
wealth of information. Using NovaTerm, you can send electronic
mail, browse message forums, download software from libraries,
participate in conferences, and maybe even browse the World Wide
Web. (If you don’t know what all these terms mean, don’t worry—
this guide can teach you everything that you need to know.)

If you connect to more than one service, you'll find that each one is
different. You'll see different pictures, hear different sounds, and
discover a diverse assortment of forums, libraries, and conferences.
Because each service is unique, there’s no telling exactly what
you’ll see when you connect to a new service, but the NovaTerm
interface makes it easy to explore.

GETTING STARTED

When you first connect to a service, you'll see a survey, a welcome
window, or the service’s main menu. Some services also play a
welcome sound or message.

Surveys. Some service administrators ask a series of questions when
users connect to their service. This type of survey is presented in a
simple text window. Questions appear, one at a time, and
NovaTerm waits for you to type in an answer and press your Return
key. Once you complete the survey, NovaTerm closes the text
window opens a welcome window or the main menu.



Weilcome Windows. Most welcome windows contain a message
from the service administrator. They may also include hotlinks,
which you’ll learn more about in Chapters 4 and 9. After reading
the welcome notice, click Continue to open the service’s main menu.

Main Menus. Each service has a main menu to help you find your
way around the service. The next section explains NovaServer’s
navigational menus in more detail.

USING NAVIGATIONAL MENUS

Navigational menus are jumping off points that let you open a
variety of other areas, including other menus.

NovaView menus. Menus that represent choices with a standard
set of icons are known as NovaView menus. These menus look and
work a lot like the basic Macintosh or Windows interface. To open
an item in a NovaView menu, double-click its icon.

E[[&——=—== NovaServer 4.0 irea =———=
¥

NS Technical
Options Suppaort

Online 4.0 4.0 Externals File Libraries MNovaServer
Manual Area Discussion

Custom menus. Other menus use custom graphics that are unique to
the service. Items in these menus are represented by buttons or
images within the menu graphic. To open an item in this type of
menu, click the button or image.

MAIN MENU

NV R LER TR
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EXPLORING

Now that you know the basics, you can explore a service by opening
the items its navigational menus. Just keep clicking until you learn
your way around. To help you get started, here are a few brief
explanations of the most fundamental elements of a service. The
icons shown next to each description are the standard NovaView
icons for that item. To learn the rest, you'll have to keep reading.

Menus may contain buttons or icons, like this one, that open other
navigational menus.

Documents within menus may be messages, surveys, or even
pages on the World Wide Web. For more about web pages, see
Chapter 9, “Using the Web Browser.”

Message forums are public discussion areas where people read and
post messages on various topics. For details, see Chapter 4, “Using
Public Message Forums."”

File libraries are public areas for exchanging files. For more
information, see Chapter 6, “Using File Libraries.”

Conferences are public areas where people hold “live” discussions
while they are online. To learn more, see
Chapter 8, “Communicating with People Online.”

GETTING HELP ONLINE

NovaTerm makes it easy to explore new services, but if you need
some extra help using NovaTerm or learning your way around a
service, use the online help system. The help pages specifically
address the service that you are connected to.

Tip: If you have questions that are not answered in the online help, you
should contact the service administrator. Administrators, also known as
admins or sysops (system operators), can help you learn to use the service
and assist you with any problems that you may encounter. You can contact
most administrators through electronic mail—their e-mail addresses are usually
listed in the welcome window, online help, or other public message.
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To open the NovaTerm online help window:
* Choose Online Help from the Help menu.
Or,

Double-click the help icon or click the help button.

NovaCentral Help

This help docwment was created using HTML.
You may select help pages on the following :

»  MovaTerm Graphics

= E-Mail, Forums, and File Libraries

=  Person to Person Clonununication

= Internet Services

= Creating Your Own NovaServer Svstem

Most help systems also contain hotlinks that open help pages on
related topics. Some hotlinks open other areas on the service or
even on the Internet.

Hotlinks usually look like blue underlined words or phrases. When
you move the pointer over a hotlink, the arrow becomes a hand.

To open a hotlink:

e Click the hotlink.

The arrow buttons in the help window also make it easy to flip
through recently opened pages.

To open the previous page that you viewed:

*  Click the left arrow button at the top of the window.

To go back to the former page:

*  Click the right arrow button at the top of the browser window.
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USING THE
SERVER MESSAGES WINDOW

When you connect to NovaServer, NovaTerm opens the Server
Messages window. This window lets you monitor your session on the
service and provides you with other valuable information. If this
window is not visible, you can open it by choosing Server Messages
from the Windows menu.

ages

i

Server Mess

Rob ¥reeland just logged on.
Rob ¥reeland just 1ogged off.
Crash just logged off.

Aron Yieira just logged on.

The number in the upper left of the Server Messages window shows
how long you have been connected to the service during the current
connection. The number in the upper right shows how long you are
permitted to remain connected. Time restrictions, when they exist,
are imposed by the service administrator and can limit the amount
of time that you can be connected during a given period of time or
during a single connection. The bar between the two times shows the
progress of transactions between NovaTerm and NovaServer.

The lower portion of the Server Messages window shows who
connects to the service, who disconnects, who you send e-mail to,
and who you receive e-mail from. It also warns you when you are
running out of time for your connection and shows you bulletins that
other people online send you. (For more information on bulletins, see
“Sending a Bulletin” in Chapter 8.)

OTHERNOVATERM BASICS

There are a few more things you should know before you dive in.

OPENING AND SAVING DOCUMENTS

NovaTerm lets you create, open, and save new documents, as well as
forum and e-mail messages.
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To

To

3

create a new document:

Choose New Document from the File menu.

NovaTerm lets you change the style of the text and add pictures, hotlinks,
and HTML to documents. For more information on using these features,
see "Dressing Up Your Messages” in Chapter 4.

save a document, including forum and e-mail messages:

With the document open, choose Save from the File menu.

If the document was saved previously, you do not need to do anything
more. If you want to save another copy of it, choose Save As... from the
File menu and proceed to step 2.

If the document has not been saved previously, use the dialog to name
the document and select a destination for the saved file.

Click Save.

To open a document or message that is saved on your disk:

I
2

Choose Open Document... from the File menu.

Use the dialog to locate the item you want to open, and click Open.

PRINTING DOCUMENTS

NovaTerm can print documents, forum messages, and e-mail.

To configure the page setup:

I
2

Choose Page Setup... from the File menu.

Adjust the page setup and click OK.

To print a document:

i
2
3

20

Open the item that you want to print.
Choose Print... from the File menu.

Click Print.
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MANAGING WINDOWS

NovaTerm can open a number of windows to display different items.
When you have several windows open at once it is easy to loose
track of them. The Windows menu lists all of the open windows, as
well as the Server Messages and URL History windows, which are
always available.

To bring any window to the front:

Select the name of the window from the Windows menu.

CHANGING YOUR PASSWORD

Most services let you change the password that you use to connect to
the service. Changing your password periodically helps ensure the
privacy of your account.

To change your password:

|
2

Connect to the service, as described in Chapter 2.

Double-click icon or click the button for changing your password.

Edit Password

st

“Cancel

Type a new password in the first field, then click in the second field and
type the same new password.

As you type each password, dots appear instead of characters so no one
else can see what you type.

Click OK.

As long as the password in the first and second fields are identical, your
password is changed to that password.
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USING NOVATERM IN OTHER LANGUAGES

You can choose what language NovaTerm uses to display its
menus and dialogs.

To use NovaTerm in another language:

I Open the Preferences window by choosing Preferences... from the
File menu.

= Preferences

D Auto-Open Receive Files E Include Message With Reply

[ Receive Folder | current: Receives

The pop-up menu in the upper right contains a list of the available
languages and displays the currently selected language. Some versions of
NovaTerm may not have languages other than English available.

2 Choose a different language from the Language pop-up menu.

A FEW MORE FEATURES

NovaServer systems offer a variety of features, including the
ability to connect to other network sites.

USING TELNET TO CONNECT TO
OTHER SITES THROUGH NOVASERVER

Services that are connected to TCP/IP networks may allow you to
connect to another site or BBS (Bulletin Board System) using a text
interface. This outgoing connection is established using the standard
Internet protocol known as Telnet.

Telnet connections can be represented by this icon, or
by a custom button or graphic.

Telnet Out

Some services offer Telnet connections to a specific site, while
others allow you to choose which site to connect to.
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—

K Flease enter your terminal tupe (? for examples) or <CR* for none:

- <0 HoloMet Demo C(FREE>

b [H] Help System

To Telnet to another service:

I Double-click the Telnet Out icon or click the Telnet button.

The Telnet window opens. If the Telnet connection allows you to

choose which site to connect to, you are prompted to enter the network
address.

2 If you are prompted to enter a network address, type the address of
the site that you want to connect to, and press the Return key.

The network address can be a domain name, like resnova.com, or an
address, like 204.74.76.1 1.

F)

_————m—————— leut Inteiface

£l

&

35
el W (111}

HoloMet(SM>» -- A service of IAT

HoloMet Member Mame (Non-members type “guest”): guest
s Last login: Tue Aug 8 12:89:11 from novacentral .resn

HoloMet(SM) Guest Services

Note: Prompts ending in a question mark ¢°?°) do not require a <return>.

HoloMet Guest Menu

[I] HoloMet Information
¢N» Find the closest HoloNet Access Number
<Jr Join HoloMet (Mot Free)

{T» Set Terminal Tupe
ESC Disconnect from HoloNet
Your Choice? [

NovaServer connects to the other site. Once this connection is
established, the text interface is provided by that site.

You can disconnect by holding down the Control (ctrl) key and typing E.
When you disconnect from the site, the Telnet window closes.

= VOTING

Some services poll users on various questions. Each poll asks a
question and allows you to choose from among several answers.

Polls may be represented by this icon, or by a
custom button or graphic.

To vote in a poll:

— I Double-click the poll icon or click the poll button or graphic.
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What age group are youin?

5-10

16-20

26-30

41-50

No comment...

11-15
21-25
31-40
50+

The question appears at the top of Vote window.

Click the button next to your answer.

The button you clicked will be highlighted. If you want to change your

vote, click another button.

Click Vote

ENEE=—————= fige

‘What age group are you in?

1) 5-10
2) 11-15

3) 16-20

4) 21-25

S S8-30

£) 31-40

7) 41-50

8) S50+

9) No comment. . .

A total of 27 have voted.

0%

14%
22%
25%
18%
2 1
3%
3%

Lot ool e B 4 S« U )

=]
R

{4}

NovaTerm displays the result of the poll so far. Once you have voted,

you cannot vote again. If you open the poll, you will see the most recent

poll results instead of the Vote window.
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CHAPTER FOUR

USING PUBLIC
MESSAGE FORUMS

In this chapter, you'll learn all about NovaServer message forums, including
how to read and post public messages.

INTRODUCING MESSAGE FORUMS

Message forums are public discussion areas where people browse and
post messages about shared interests. Each NovaServer has its own
assortment of forum topics. Once you are connected to a service, look
for a forum topic that interests you. If you're not sure where forums
are located on the service, just click around and explore.

Message forums can be represented by this icon, or
by a custom button or graphic.

Messages can include words, pictures, file attachments, and hotlinks
to other items on the service or on the World Wide Web.

Note: NovaTerm transparently translates each message into HTML
(HyperText Mark-up Language), a standard language used to describe
documents on the World Wide Web. To learn how to take advantage of this
feature, see “Dressing Up Your Messages,”" later in this chapter.

To open a message forum:

¢ Double-click the message forum icon or click the custom button or
graphic that represents the forum.

NovaServer Discussion

Subject [ List New Only Sent By Date #

martin polanic 5:47 FM 75795

i
----- ... tmier 8:55 AM 8/4 /95 i

[ winsock.dn John House 749 &M 874795 Z [

[ ResMova Software, Inc. Keith MeCallion 1107 PMBIZ/IS 2




The forum list includes messages and folders. Folders contain a series of
messages on a single subject, known as a message thread. The numbers
on the right show how many messages are in a thread.

For each item, the list shows a subject, sender, and date posted. ltems
are initially sorted by date. To sort by a different attribute, click that label
above the list. The underline shows how the list is currently sorted.

Messages that have been posted since the last time you opened the
forum are marked by a red dot. To view only the new messages, click the
List New Only checkbox at the top of the mail list.

READING MESSAGES IN FORUMS

26

Once you open a forum, read the message threads that interest you.

Note: On most services, messages are deleted after a period of time.

To read posts in a message forum:

If you haven’t already done so, open the forum by double-clicking its
icon or clicking the button or graphic that represents it.

Select the message or thread that you want to read by clicking its name
in the forum window.

Click Read.
Or,

Choose Read from the Messages menu.

=] Good Words

'u‘ RO e RSO AR i i 9% % -
‘well, | am one of the lucky people who lives in Southern California, and qot the
chance to meet with ResNowva Software. They are a great bunch, and I'Tl get
into a little rmore detail about each person | meet with.

| was greeted by a nice secretary , who was very polite, which | found very
nice for a company. Then Jim and | meet, we said hello, and started to talk
about how everything changed, and the pew software. We walked around the

If you selected a thread, a list of the messages in thread opens. To read a
message, select its name and click or choose Read again.

The top of the message shows the names of the sender and the person
to whose attention the message was sent, the message subject, and the
date the message was sent, including the time and time zone.
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Note: NovaServer does not limit message size, but large messages may
take longer to open. As the message opens, you can monitor its progress
in the Server Messages window.

RETRIEVING FILE ATTACHMENTS

Some messages include attached files. If a message has an attached
file, the filename appears below the icon in the top right corner of
the message window and a Receive button is present so that you can

retrieve the file.

Tip: NovaTerm gives you the option of automatically opening the files that
you retrieve. To tum this option on, choose Preferences... from the File
menu and check the Auto-Open Receive Files box to check it.

To retrieve a file attachment:

Click Receive.
Or,

Choose Receive File from the Messages menu.

A file transfer window opens and NovaTerm downloads the file. When
the transfer is complete, NovaTerm will close the file transfer window.
For more information on file transfers, see "“Working with File Transfers"
in Chapter 6.

The downloaded file is saved in your receive folder. When you install
NovaTerm, this folder is automatically created in the NovaTerm folder
and titled “Receives.” You can define a new receive folder or check the
name of the current one in the NovaServer Preferences window. For
more information on the receive folder, see "Defining a new receive
folder” in Chapter 6.

FINDING HOTLINKS IN MESSAGES

Some messages also contain hotlinks, or clickable areas that open
pages or documents on the local service or on the Internet when they
are clicked. Hotlinks usually look like blue underlined words or
phrases in a message. When you move the pointer over a hotlink,
the arrow changes into a hand. Hotlinks can link to another
document or file on the service, or even to an item on the Internet or
World Wide Web.

To open a hotlink:

Click the hotlink.
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2  Enter the forwarding address in the To field.

For more detailed information about addressing e-mail messages, see
“Sending E-Mail” in Chapter 5.

3 You can edit the body of the message or add a note before sending it.

4 Click Send.
USING NAVIGATIONAL BUTTONS TO READ MESSAGES

When you're ready to read another message, the arrows in the
1 message window allow you to quickly open the next or previous
message in the current thread or the first message in the next or
previous thread.

Note: NovaTerm navigates message forums and threads chronologically. The
next message or thread is a newer one, and the previous message or thread is
an older one.

To read the next message in the current thread:

- * Click the . button in the message window.

— To read the previous message in the current thread:

= e Click the « button in the message window.

To read the first message in the next thread:

— ¢ Click the button in the message window.

To read the first message in the previous thread:

e Click the button in the message window.

N POSTING MESSAGES TO FORUMS

Remember, forums are public areas—this means lots of people will
read what you post.

Note: Some message forums may not let you post new messages. If this is
—=m the case, the Send button will be unavailable. Also, on most services, your
posts will automatically expire after a certain period of time.

Chapter 4: Using Public Message Forums 29



To post a message to a forum:

I Open the message forum by double-clicking the forum icon or clicking
the custom button or graphic that represents the forum.

2 Click Post.

Post a Message

3 If you want to direct your public message to someone specific, type
that person’s name in the Attn field.

NovaTerm does not send a copy of the message to that person, but it
shows the name at the top of the message so that people know who
you are addressing or responding to.

4 Click in the Subject field and type the subject of your message.

5 Click in the body of the post and type your message.

Your message may contain styled text, including different fonts, font sizes,
colors, and attributes such as bold and underline, and italics. You may also
include hotlinks to items on the service or the Internet, or create your
message in HTML. For more information on these options, see
“Dressing Up Your Messages” in Chapter 4.

Note: Hotlinks and HTML in messages work only for NovaTerm users.
Do not include hotlinks or HTML if you are posting in an Interet
newsgroup or in a message forum that is shared through a gateway with a
non-NovaServer system. If you do not know which forums are shared
with remote systems, please ask the NovaServer administrator.

6 If you choose, you may attach a file to your message, as explained in
“Enclosing file attachments” in Chapter 5.
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7 Click Send.
Or,

Choose Send from the Messages menu.

If you attached a file, NovaTerm displays the progress of the file transfer.
The Server Messages window will notify you once the message has been
sent. For more information on file transfers, see ““Working with File
Transfers” in Chapter 6.

DRESSING UP YOUR MESSAGES

NovaTerm lets you enhance the look and functionality of any
message, including e-mail messages, by using different fonts, colors,
and styles, or by adding pictures and hotlinks.

Note: NovaTerm transparently translates each message into HTML
(HyperText Mark-up Language), a standard language used to describe
documents on the World Wide Web. With NovaTerm, you don't need to
know HTML to take advantage of it—just use styled text or make hotlinks and
NovaTerm takes care of the rest. If you are familiar with HTML, however, you
can utilize additional HTML capabilities by creating messages directly in HTML.
All these options are described below.

STYLED TEXT

When you create a forum or mail message in NovaTerm, the text
you type in the body of the message is in the 10 point Geneva font.
To make your messages more powerful and unique, NovaTerm lets
you change the font, color, and style of this text.

Note: If your message is read by someone who does not have the font or
color that you used in the message, another font or color will be substituted.

To change the font of text:
I Select the text that you want to modify.

2 Choose a different font from the Edit menu’s Font sub-menu or from
the font pop-up menu in the message window.

Before you change the font, this menu reads “Geneva.” When you select
another font, the menu shows the name of that font.
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To change the point size of the font:
I Select the text that you want to modify.

2 Choose a different font size from the Edit menu’s Size sub-menu or
from the size pop-up menu in the message window.

Before you change the size, this menu reads “10.” When you select
another size, the menu shows that size.

To change the color of the text:
I Select the text that you want to modify.

2 Choose a different color from the Edit menu’s Color sub-menu or
from the color pop-up menu in the message window.

Before you change the color, this menu reads “Black.” When you select
another color, the menu shows that selection.

To change the style of the text:
I Select the text that you want to modify.

2 To use the bold style, choose Bold from the Edit menu’s Style sub-
menu or click [E in the message window.

To use the italic style, choose Italics from the Edit menu’s Style sub-
menu or click @ in the message window.

To use the underline style, choose Underlined from the Edit menu’s
Style sub-menu or click @ in the message window.

The buttons for the styles that you select will be highlighted. To turn off
any of these styles, click the highlighted button. To tumn off all of these
styles, choose Normal from the Style sub-menu in the Edit menu.

PICTURES

You can paste pictures from the Clipboard directly into the body of
any forum or mail message that you are creating.

To add a picture to a message:

I Copy the picture that you want to add to the message.

You may select an image from any program that allows pictures to be
copied to the Clipboard, including graphics programs, word processors,
and NovaTerm. To copy an image within most programs, including
NovaTerm, select the image and choose Copy from the Edit menu.
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2 Click where you want to place the image in the body of the message.

3 Choose Paste from the Edit menu.

The image is added to the message.

HOTLINKS

Hotlinks are clickable areas that open pages or documents on the
local service or on the Internet when they are clicked. Usin
NovaTerm, you can create hotlinks in the body of a forum and mail
messages, and even in file descriptions. By including a hotlink in a
message, you allow anyone who reads the message to open the
linked item with a single click.

Note: To create a hotlink, you must know the URL (Uniform Resource
Locator) of the item that you want the hotlink to open. Also, to use the
hotlink, the reader must have the appropriate access privileges to open that
item. Hotlinks work only in messages read by other NovaTerm users. Do not
include hotlinks in posts or mail that can be read by someone who does not
use NovaTerm, including most Internet mail and newsgroup posts.

To create a hotlink:
I  Complete the body of the message before you create the hotlink.

2 Select a word or phrase in the message body that you want to turn into
a hotlink.

3 Choose Make Hotlink... from the Messages menu.

ttp://www.resnova.com/

4 Type the URL for the item that you want the hotlink to open.

5 Click Enter.

You can recognize the hotlink because the text is blue and underlined,
and, if you move the pointer over it, the arrow changes into a hand.
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Tip: Once you create a hotlink, click it to make sure it works properly. If the
hotlink connects to a message or other item on the service, that item should
open just as if you had opened it from a navigational menu or list of messages.
If the hotlink connects to a homepage or a document on the Internet or
World Wide Web, the NovaTerm browser window should open displaying
that page or document. For more information about the NovaTerm browser,
see Chapter 9, “Using the Web Browser."

HTML
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HTML (Hyper-Text Mark-up Language) is the language used to
describe documents on the World Wide Web. NovaTerm messages
all use HTML transparently, but if you are versed in HTML you can
type HTML directly into the body of any forum or mail message
that you create.

Note: HTML works only in messages read by other NovaTerm users. Do
not include HTML in posts or mail that can be read by someone who does
not use NovaTerm, including most Internet mail and newsgroup posts. Also, if
you choose to use this feature and you want to use stylized text or hotlinks

in your message, you must include the styles and hotlinks in your HTML text.
Styles and hotlinks added to the message using NovaTerm's menus and
buttons will be ignored.

To include HTML directly in the body of a message:

I Begin and end the body of the message with HTML tags.

If NovaTerm finds the <HTML> tag at the beginning of a message, it
preserves your HTML rather than translating the text into HTML. When
the message is read, NovaTerm will interpret and display your HTML.
(NovaTerm only checks for the opening tag when you send a message,
but make sure you don't forget the </HTML> tag at the end—
NovaTerm expects this tag when it displays the message.)

2 Create the body of the message using HTML.

NovaTerm 4.0 only recognizes HTML Level |. Do not include HTML 2.0
Level 2 or Level 3 tags, including forms, as they are not supported in this
version.

Tip: Errors in your HTML text can prevent NovaTerm from properly
displaying your document. To avoid problems, make sure that all quotes and
tags in your document are balanced. You can also check your HTML to make
sure that it is free of this type of error by testing it with a “validating parser.”
Several of these parsers are available on the Internet.
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CHAPTER FIVE

USIN
ELECTRONIC MAIL

B In this chapter, you'll learn how to send and receive electronic mail.

INTRODUCING ELECTRONIC MAIL

Just like paper mail, electronic mail, or e-mail, is a private
message sent from one person to another. You can send and receive
e-mail by connecting to a NovaServer service. Some services even
let you exchange e-mail with people over the Internet.

Like other messages on NovaServer services, e-mail messages can
include file attachments, HTML, and hotlinks to web pages.

Note: While e-mail is intended to be private, it is possible for messages to
be monitored by system administrators or intercepted on the Intemet. While
such breaches of privacy are uncommon, they can occur. We recommend that
you keep this in mind when using e-mail.

SENDING E-MAIL

Once you are connected to NovaServer, sending e-mail is simple.

Some services have icons or buttons that make sending mail even
easier. This icon opens a blank e-mail message.

This icon opens an e-mail message that is automatically addressed
to a specific user.

To send electronic mail:

I Choose Compose Mail from the Messages menu.
Or,

Double-click the send mail icon or click a send mail button.
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Type recipient’s screen name or e-mail address in the To field.

You can send the letter to multiple recipients by typing each screen name
or address separated by a comma.

When you click in another field, NovaServer checks to make sure that the
screen name or address you entered is valid. For help with addresses, see
“Working with addresses and auto-addressing” below.

Click in the Subject field and type the subject of your message.

Click in the body of the message and type your note.

Your message can contain styled text, including different fonts, font sizes,
colors, and attributes such as bold, underline, and italics. You can also
include hotlinks to other items on the service or the Internet, or create
your message in HTML. For more information on these options, see
“Dressing Up Your Messages" in Chapter 4.

Note: Hotlinks and HTML in e-mail messages work only when you send
e-mail to other NovaTerm users. Do not include hotlinks or HTML if
you are sending a message over the Intermet or to someone who does
not use NovaTerm to read e-mail.

If you want a return receipt, click Rept.
Or,

Choose Return Receipt from the Messages menu.

A return receipt will notify you when the recipient opens the message.
When this option is selected, the Rept button and Return Receipt menu
item display a check mark. You can tum this option off by clicking Rept
again or by choosing Return Receipt again.

Note: Return receipts may not work over the Internet. NovaServer's
receipts are supported by NovaTerm and Eudora, but other e-mail
readers may not properly generate the receipt.
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If you choose, you may attach a file to your message, as explained in
“Enclosing file attachments” later in this chapter.

Click Send.
Or,

Choose Send from the Messages menu.

If you attached a file, NovaTerm displays the progress of the file transfer.
The Server Messages window will notify you once the message has been
sent. For more information on file transfers, see “Working with File
Transfers' in Chapter 6.

PREPARING E-MAIL BEFORE CONNECTING TO A SERVICE

NovaTerm lets you create e-mail messages before you connect to a
service. Once you create mail “off line,” you can connect and
quickly send all the messages that you prepared in advance.

To prepare e-mail before connecting to a service:

Choose Compose Mail from the Messages menu.

A blank e-mail message opens. The From field shows the screen name
saved in the currently selected service file. If this is not your screen name,
replace it by selecting it and typing your screen name.

Address and compose the message as described in steps 2 — 6 above.

To save the message and send it later, skip to step 4. To send the
message immediately:

a Click Send.

Or,

Choose Send from the Messages menu.
b Click Connect. (Skip the remaining steps.)

NovaTerm connects to the service that is selected in the services
menu and sends the message.

To save the message and send it later:
a Choose Save from the File menu.

b Use the dialog to name the message and to select a destination for
the message.

Chapter 5: Using Electronic Mail 37



To have NovaTerm send the message for you, you must save it in
the outgoing mail folder (or sub-directory) for the service that you
want to send the message from. NovaTerm creates an outgoing
mail folder for each service file in your Services folder. Each outgoing
mail folder has the same name as the service file it corresponds to
and is located in the Outgoing Mail (or Outgoing) folder within the
NovaTerm 4.0 Folder.

¢ When you connect to a service, choose “Send Outgoing Mail” to
send all the messages that you saved in that service’s outgoing mail
folder.

WORKING WITH ADDRESSES AND AUTO-ADDRESSING
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The address in the To field tells NovaServer where to send the
message. When you send a message to a local recipient (someone
using the same service), use that person’s screen name as the
address. If the recipient is using another NovaServer service that
is connected through InfoLink, the address will be the screen name,
followed by “/” and the name of the other service. If you are
sending a letter to someone over the Internet, you will need his or
her e-mail address. An Internet e-mail address is made up of a

name, followed by the “@” symbol and the name of an Internet site.

For help with InfoLink or Internet addresses, contact your
NovaServer administrator.

When you enter an address in the To field and click in another
field, NovaServer checks to make sure that the address is valid. If

you send a message to a local user, NovaServer checks a list of users

to make sure that it recognizes that screen name, or a screen name
containing the characters you entered. If the name is not found, you
will need to enter a valid address. If you entered an InfoLink or
Internet address, it is always considered valid. (If the message is
then sent to an invalid address, it will be returned to you.)

If you want to send a message to a local user but don’t know the
exact screen name, use NovaServer’s auto-addressing feature.

To use auto-addressing:

I Type a portion of the intended recipient’s screen name.

You must use at least three characters. If the screen name has multiple
words, you can type the first letters of each word separated by a space.

2 Click in another field.

NovaServer searches for a match in its list of users and completes the
screen name for you. If it finds more than one matching screen name, it
will allow you to select one of the matching names, as shown below.
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Cancel

3 To specify the screen name of the intended recipient from a list of
matching names, click the correct name and then click Select.

ENCLOSING FILE ATTACHMENTS

When you send e-mail or post a message to a forum, NovaServer
gives you the option of including a file with your message.

Note: Sending file attachments over the Internet can be tricky. NovaTerm
sends e-mail in a standard Intemet format called MIME (Multipurpose Internet
Mail Extensions). MIME is recognized by many popular e-mail readers, including
Eudora. The problem is that some e-mail readers and online services use their
own non-standard e-mail formats instead of MIME. If you send e-mail from
NovaServer to people who are not using a MIME-compliant e-mail reader,
they will be able to open and read your message, but they will not be able to
receive the file attachment. The file attachment will appear as garbage
characters in the body of the message.

To attach a file to a message:
I Within the message window, click Attach.

Or,

Choose Attach File... from the Messages menu.

O Billing Fject
O Contracts ;
O New Projects - Desktop
O Project Archive

0 To Do List _

Cancel

Open

{}.

2 Use the dialog box shown above to locate the file you want to attach,
and select the file by clicking its name.

Chapter 5: Using Electronic Mail 39



3 Click Open.

The name of the attached file is displayed below the icon in the top right
comer of the message window. When you send the file, NovaTerm
displays the progress of the file transfer. For more details about file
transfers, see “Working with File Transfers” in Chapter 6.

Until you send the message, you may change or remove the
file attachment.

To change the attached file:

* Follow the steps above to attach a file, selecting the new file.

The new file replaces the previously selected file. The new file name is
displayed below the icon in the top right cormner of the mail message.

To remove a file attachment:
| Within the message window, click Attach.
Or,
Choose Attach File... from the Messages menu.

2 Click cancel.

The filename no longer appears below the icon in the top right corer of
the message window and no file will be included with the message.

READING YOUR E-MAIL

40

E-mail that you receive is stored in your private mailbox. When
you connect to a NovaServer service, you are usually notified if you
have unread mail. If you receive mail while you are connected, you
will be notified in the Server Messages window.

On some services you may find this mailbox icon or another
button or graphic representing your mailbox.

To read your mail:

I Choose Open Mailbox from the Messages menu.
Or,

Double-click the Mailbox icon or click the Mailbox button.
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Subject [ List New Only

I've been a busy boy this weekend... kindall@so journ.com (... &30 PM 7/237/95
Appendix 1 available kindall@sojourn.com (... 143 P 7/22/95

Manual Update Jerry K/ ;
=] Mew chapters Jderry K/NovaCentral  7:37 AM 776798 |53

Your mailbox contains a list of your mail, specifying the subject, sender,
and the date and time each message was sent. Mail is initially sorted by
date and time. To sort by subject or sender, click that label at the top of
the mail list. The underline indicates the attribute by which the list is

currently sorted.

Messages that include file attachments are marked by the [lsd icon and
unread messages are marked by a red dot. To view only your unread
messages, click the List New Only checkbox at the top of the mail list.

2 Select the message that you want to read by clicking its name.
3 Click Read.
Or,

Choose Read from the Messages menu.

Heading aletter _IT=

Could it get any hotter ? i

The top of the message shows the sender, the recipient, the subject, and
the date the message was sent, including the time and time zone.

Note: NovaServer does not limit message size, but large messages may
take longer to open. As the message opens, you can monitor its progress
in the Server Messages window.
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RECEIVING FILE ATTACHMENTS IN E-MAIL

Some messages include attached files. If a message has an attached
file, the filename appears below the icon in the top right corner of
the message window and a Receive button is available so that you

can retrieve the file.

Tip: NovaTerm gives you the option of automatically opening the files that
you receive. To turn this option on, choose Preferences... from the File
menu and check the Auto-Open Receive Files box.

To receive a file attachment:
e Click Receive.
Or,

* Choose Receive File from the Messages menu.

A file transfer window opens and NovaTerm downloads the file. When
the transfer is complete, NovaTerm will close the file transfer window.
For more information on file transfers, see “Working with File Transfers”
in Chapter 6.

The downloaded file is saved in your receive folder. When you install
NovaTerm, this folder is automatically created in the NovaTerm folder
and titled "Receives.” You can define a new receive folder or check the
name of the current one in the NovaServer Preferences window. For
more information on the receive folder, see "Defining a new receive
folder” in Chapter 6.

GETTING HOTLINKS IN E-MAIL

42

Some messages also contain hotlinks to other items on the service or
the Internet. Hotlinks usually look like blue underlined words or
phrases in a message. When you move the pointer over a hotlink,
the arrow changes into a hand. Hotlinks can link to another
document or file on the service, or even to an item on the Internet or
World Wide Web.

To open a hotlink:

e Click the hotlink.

If the hotlink connects to a message or other item on a NovaServer
service, that item opens as if you had opened it from one of the service's
menus or lists of messages. If the hotlink connects to a homepage or a
document on the Internet or World Wide Web, the NovaTerm browser
window opens, displaying that page or document. For more information
about the NovaTerm browser, see Chapter 9.
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REPLYING TO E-MAIL

Once you've read a message, you can reply to it. When you reply to
a message, your response is automatically addressed to the
message’s sender.

Tip: NovaTerm gives you the option of including the original text of a
message in your replies. To turn this option on, choose Preferences... from
the File menu and check the Include Message With Reply box.

To reply to a message:

Within the message window, click Reply or choose Reply... from the
Messages menu.

Or,

Select the message in your mailbox and click Reply or choose Reply...
from the Messages menu.

The reply is automatically addressed to the sender in response to the
subject of the original message.

2 Complete the body of the message.

3 Click Send.

FORWARDING MESSAGES

You can also send someone a copy of a message that you received by
forwarding the message to them.

To forward a message:

Within the message window, click Forward, or choose Forward...
from the Messages menu. !

A new mail message window opens with the same subject and body as
the original message.

File attachments are not automatically included in the forwarded message.
If you want to include a file that was attached to the original message, you
must retrieve the file and attach it to the forwarded message, as described
in “Receiving file attachments in e-mail"” and “Enclosing file attachments,”
earlier in this chapter.

Enter the forwarding address in the To field.

For more information on addressing e-mail, see “Sending E-mail” earlier in
this chapter.
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3  You may edit the message or add a note before sending it.

4 Click Send.
DELETING E-MAIL

Mail that you have received remains in your mailbox until you
delete it.

To delete mail from your mailbox:

I Within the message window, click Delete or choose Delete... from
the Messages menu.

Or,

Select the message in your mailbox and click Delete or choose
Delete... from the Messages menu.

2 Click Yes to confirm this action.
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CHAPTER SIX

SING FILE LIBRARIES

B In this chapter, you'll learn about file libraries, and how to download files from
them and upload files to them. You'll also learn about file transfers.

INTRODUCING FILE LIBRARIES

File libraries are public areas for exchanging files. Getting a copy
of a file from a library is known as “downloading” the file. Adding
a file to a library is known as “uploading” the file to the library.

button or graphic.

To open a file library:

File libraries can be represented by this icon, or by a custom

Double-click the file library icon or click the custom button or graphic
that represents the library.

Online 4.0 Manual

FileMare Date Size Downloads
HTHML tags supported in NS 4.0 7/25/95 3K 55
Thiz ig a Microsoft Word Doz,

NS 4.0 Chapter 8 of the prerelease mar7/23/95 25K S&
CHapter B8 of the manual in Adobe Acrobat Format

NovaTerm.pdf ®1 7721795 Sk 20
NS 4.0 pre-release manual all chapters?7/21/95 263K €3
WS rnanual in Adobe Acrobat format

NS 4.0 Read Me of the pre-release man7/21/95 ZK &

Read me in Adobe Acrobat format
NS 4.0 Chapter & of the pre-release mi7/21/95
Chapter & in Adobe Acrobat format

o,
Suk

£

5

The library opens containing a list of files. Below the name of each file is a
brief description of its contents. Each file is listed with the date the file
was uploaded, the file's size, and the number of times the file has been
downloaded.
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ltems are initially sorted by date. To sort by filename, file size, or number
of downloads, click that label at the top of the message list. An underline

indicates the attribute by which the list is currently sorted.

Note: Most file libraries allow you to upload and download, but some place
restrictions on one or the other. If you are not allowed to upload files, the
Send button is unavailable. If you are not allowed to download a file, the
Receive button does not become available when you click the file’s name.

SEARCHING FILE LIBRARIES
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File libraries can contain many files, so NovaTerm provides a
search capability that helps you find the files that you want. The
search compares the word or phrase that you enter with the file’s
name and both the brief and detailed descriptions of the file.

To search the file library:

If you haven’t already done so, open the file library by double-clicking
the library icon or clicking the custom button or graphic that
represents the library.

Click Search

Type the word or phase that you want to search for.

Click OK.

NovaTerm searches the filenames and descriptions in the library. Any file
that does not match the word or phase you are looking for is taken out
of the listing in the library window, leaving only those files that match your
search. When the search is complete NovaTerm will beep.

To view all library listings after a search:

Click Reload.
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DOWNLOADING FILES
FROM LIBRARIES

Once you open a library, you can look through its listings and
download those files that interest you.

Tip: NovaServer gives you the option of automatically opening the files that
you download. To turn this option on, choose Preferences... from the File
menu and check the Auto-Open Receive Files box to check it.

To download a file from a library:

If you haven’t already done so, open the file library by double-clicking
the library icon or clicking the custom button or graphic that
represents the library.

Select a file by clicking its name.

Click Receive.

NovaTerm 4.0 Pre Release Manual

Kind : documnent

Size: 20212

From: jmbarry
Accessed: 20

If you need Acrobat to read this chapter, it is available in the file area
on MovaCentral or in the PUB directory of ftp.resnova.com
{204.74.76.54).

The download window opens containing a more detailed description of
the file, and the file's type and size, who uploaded it, and the number of
times it has been downloaded. Some files, especially graphic images, also
let you view a preview of the file before downloading.

If you want to preview the file, click Preview.
To download the file, click Receive.
Or,

Choose Receive File from the Messages menu.
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A file transfer window opens and NovaTerm downloads the file. When
the transfer is complete, NovaTerm will close the file transfer window.
For more information on file transfers, see ""Working with File Transfers”
later in this chapter.

The downloaded file is saved in your receive folder. When you install
NovaTerm, this folder is automatically created in the NovaTerm folder
and titled “Receives.” You can define a new receive folder or check the
name of the current one in the NovaServer Preferences window, as
described in “Defining a new receive folder” later in this chapter.

UPLOADING FILES TO LIBRARIES

48

Uploading a file to a library adds that file to the file listing so
that other people can download it.

To upload a file to a library:

Open the file library by double-clicking the library icon or clicking the
custom button or graphic that represents the library.

Click Send.

Send a File

i

Type a name for the file in the Name field.
Click in the Note field and type a brief description of the file.

If you want to include a more detailed description, click in the body of
the message and type the description.

Your description can contain styled text, including different fonts, font
sizes, colors, and attributes such as bold, underline, and italics. You can
also include hotlinks to other items on the service or the Internet, or
create the description in HTML. For more information on these options,
see “Dressing Up Your Messages” in Chapter 4.

NovaTerm 4.0 User Guide



6 Click Attach.
Or,

Choose Attach File... from the Messages menu.

|2 Work Folder v | = Picasso

C Billing Fject
O Contracts .
0O New Projects Desktop

OO Project Archive

D To Do List '

Cancel

Open

7 Use the dialog box shown above to locate the file you want to upload,
and select the file by clicking its name.

8 Click Open.

The name of the attached file is displayed below the icon in the top right
corner of the message window.

9 Click Send.

NovaTerm displays the progress of the file transfer. For more information
about file transfers, see “Working with File Transfers” below.

A file transfer window opens and NovaTerm uploads the file to the
library. When the transfer is complete, NovaTerm will notify you and
close the file transfer window. For more information on file transfers, see
“Working with File Transfers” below.

Note: When you upload a file to a library it will not appear in the library
listing immediately. In most cases a service administrator must first
approve the file for release.

WORKING WITH FILE TRANSFERS

Whether you are sending mail with a file attachment or
downloading a file from a library, you are performing a file
transfer. During a file transfer you can continue to perform other
tasks, although you may notice an apparent decrease in
performance while the file transfer proceeds in the background.
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If you start more than one upload or download at a time, NovaTerm
places each upload or download beyond the first in a queue. When
the current transfer is completed, NovaTerm begins the next transfer
in the queue.

If a file transfer is interrupted before it is completed, NovaTerm
can resume the transfer from where it left off. To make this
possible NovaTerm saves the partial file in the receive folder
with “.n” appended to the end of the filename. If this partial file
is removed or modified, NovaTerm will not be able to resume the
transfer.

MONITORING FILE TRANSFERS

50

NovaTerm lets you monitor the progress of file transfers by
automatically opening a file transfer window like the one shown
below. NovaTerm opens one file transfer window while you are
sending file attachments or uploading files to libraries and another
while you are receiving file attachments or downloading files from
libraries. The window showing uploads is distinguished by an
upward arrow on the disk icon in the upper right corner of the file
transfer window, and the window showing downloads is
distinguished by a downward arrow on that icon.

File Transfer ee————|

% Manual.sea ¥
4 Bytes Sent: 145K
Out of: 269K
Kind : document Bits/Sec: 10112
Size: 269K Peak : 63336

NS5_RDHME FPDF

NS_CHO8 PDF

The upper portion of the file transfer window contains information
about the current file transfer. It indicates the filename, its kind,
and its size. The progress bar in the upper left indicates the number
of minutes remaining before the transfer is complete. The indicators
below that progress bar show the number of bytes of the file that
have been transferred so far, the total number of bytes in the file
being transferred, the transfer rate in bits per second, and the peak
transfer rate thus far.
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The lower portion of the window lists the files in the queue, along
with their file size. The next file in the queue is at the top of the
list. The progress bar in the lower portion of the window indicates
the total time remaining to complete all the file transfers in the
queue, including the transfer in progress.

Using the buttons in the lower portion of the window, you can take
any file out of the queue or cancel all the file transfers at once.

To cancel the transfer of the current file:
*  Click Skip.

To cancel the transfer of a file in the queue:
| Select the file by clicking its name in the queue.

2 Click Remove.

To cancel all the current and queued transfers:

e Click Cancel.

DEFINING A NEW RECEIVE FOLDER

Whenever you receive a file attachment or download a file, the
file is saved in your receive folder (or sub-directory). When you
install NovaTerm, this folder is automatically created in the
NovaTerm folder and titled “Receives.” You can define a new
receive folder or check the name of the current one in the
NovaServer Preferences window.

To define a new receive folder:

I Choose Preferences... from the File menu.

Preferences

|:] #uto-Open Receive Files E Include Message With Reply

[ Receive Folder ] Current: Receives

The name of the current receive folder appears in the lower left comer of
the window.
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Select a Folder:

|= Hard Disk ¥ |

O Applications
O Development
O Finances

[ Games

O System Folder
O Telecom
O Temporary ltems

| Select “Misc”

3 Use the dialog box shown above to locate the folder that you want to

— Hard Disk
flact

Desktop

Cancel

define as your new receive folder, and click its name to select it.

4 Click the Select button showing the name of the selected receive

folder.

The current receive folder indicator shows the name of the newly

selected receive folder.
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(.__ ‘ CHAPTER SEVEN

g SEARCHING THROUG
POSTS AND OTHER
DOCUMENTS

B In this chapter you'll learn a few tricks to help you find the items that interest
you among the wealth of information and files on each service.

5 SCANNING FOR NEW ITEMS
IN FORUMS AND LIBRARIES

NovaTerm lets you find new posts without looking through each
forum and library individually. The NewScan feature searches a
portion of the service for messages and files that have been posted
in forums and libraries since the last time you opened these areas.

PERFORMING A NEWSCAN

The NewScan button looks for new posts in the message forums and
file libraries in the menu where it is located and in the sub-menus
of that menu. You can limit the search further by editing the
subscription list as described in the next section.

To search for new messages or files:

* Double-click the NewScan icon or click the NewScan button.

This is the standard NewScan icon, but some services may

use a custom button or a different name. If you are not
St sure how to locate or recognize the NewScan button,

MNewScan contact the NovaServer administrator for assistance.
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NewScan

Marne Tupe Date #
4.0 External Source Code File Library TOEPH o 1
4.0 Externals File Library 05 o 7 e N
4.0 Externals Discussion Meszage Forum 2B AM .. B
Internet Shareware File Library IS Pr .9
Mackennel teszage Forum ey 3 i RO
MenuMaker 4.0 Meszage Forum LE2E P ]
Maodern Connections Message Forum 2
MovaScript Meszage Forum e L0 P o
MNovaServer Discussion Message Forum P ol BRI
MNovaServer HTML Mezsage Forum S0 RH . - 15
NovaServer Internet Options Meszage Forum (A0 85 i B
NovaServer ODBC Message Forum L R R G g RO

The NewScan window opens, displaying a list of the message forums and
file libraries that contain new posts or uploads.

The listings are initially sorted alphabetically, but you can sort by the date
and time of the last post, or the number of new posts. To sort by a given
attribute, click that label at the top of the list. An underine indicates the
attribute by which the list is currently sorted.

To open a forum or library from the list:
I Select the area that you want to open by clicking its name.

2 Click Read.

The forum or library opens and new items are marked by a red dot.

SUBSCRIBING TO FORUMS AND LIBRARIES

When you search for new items using NewScan, NovaServer scans
only those forums and libraries that you subscribe to. When you
create a new account on a service, you automatically subscribe to
every forum and library, but scanning all these areas may take a
while and turn up much more information than you are interested
in. By editing the subscription list that is associated with a
particular NewScan, you can shorten the search time and focus on
the areas that interest you.

To edit a subscription list:

|  Double-click the subscription button or click the subscription icon.

The standard Subscription icon is shown to the left, but some
services may use a custom button or a different name, such as
“NewScan Options.”
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Select NewScan Options

Include  Name Type

X Z.11 BES Biller Message Forum
X 3.11 Bug Reports Meszage Forum
X 3.11 External Source Code File Library

X 2.11 Externals File Library

X 3.11 MacKennel Meszage Forum
X 3.11 Online Manual File Library

X 2.11 Software File Library

@,f Beta Modem Drivers File Library

X External Discussion Message Forum
.J Frequently Asked Q&4 3.11 Iessage Forumn
X MenuMaker 3.11 Message Forum
X Modemn Deals for Sysops File Library

The subscription window opens, listing all of the available forums and file
libraries. Areas that you subscribe to are marked with a “V" and areas that
you do not subscribe to are marked with an “X".

The areas in the list are initially sorted alphabetically, but you can sort out
current subscriptions or separate file libraries from message forums. To
sort by a given attribute, click that label at the top of the list. An underline

indicates the attribute by which the list is currently sorted.
2 Select a forum or library by clicking its name in the list.

3 Click the check mark button at the top of the window.

The subscription indication mark changes.

SEARCHING APPLESEARCH
AND WAIS SERVERS

Some services let you access and search through documents that are
located on AppleSearch or WAIS (Wide Area Information Server)
servers. If this feature is available, the service will have buttons
or icons that let you search specific sources.

This is the standard AppleSearch icon, but some services
have a custom AppleSearch button or graphic.

Note: AppleSearch is not available on all services. To see if it is available on
the service that you are using, contact the NovaServer administrator.
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To search an AppleSearch or WAIS server:

Double-click an AppleSearch icon or click an AppleSearch button

The locations and names of AppleSearch buttons vary from service to
service. If you are not sure how to locate or recognize an AppleSearch
button, contact the NovaServer administrator for assistance.

AppleSearch Window

FileMarne Date Size

Type the word or words that you want to search for in the box at the
top of the AppleSearch window.

Click Search.

The AppleSearch window displays a list of documents that match your
request. Each document is listed with its filename, the date it was last
modified, and its size. The number of stars on the left indicates how
closely the document matches the search criteria. Five stars represent the
closest match. ltems are initially sorted by date. To sort by filename, file
size, or number of stars, click that label at the top of the message list. An

underline indicates the attribute by which the list is currently sorted.

If the search locates a document that you would like to read, you
may open it in NovaTerm or download it to your disk. For large
documents or slower connections, downloading is recommended.

Note: Documents stored on WAIS servers can not be downloaded.

To open a document:

Select the document that you want to open by clicking its name in the
list of found documents.

Click Read.
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To download a document:

I Select the document that you want to download by clicking its name in
the list of found documents.

2 Click Receive.

NovaTerm downloads the document and saves it in your receive folder.
For more information on file transfers and the receive folder, see
“Working with File Transfers” in Chapter 6.
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- - CHAPTER EIGHT

|- COMMUNICATING
PEOPLE ONLINE

B B In this chapter you'll learn to use conferences, chat rooms, and bulletins to
communicate with other people who are currently online.

FINDING OUT WHO
IS CURRENTLY ONLINE

If you want to converse with the other people on a service, it helps
to know which people are currently available online.

On some services, you'll see this icon or a custom button
or graphic that lets you list the people who are currently

List Users online.
Online

- To see a list of the people who are currently online:
e Choose List Users Online from the Users menu.

Or,

* Double-click the List Users Online icon or click the button or graphic
8 : representing this function.

== Online Users =0
NovaTerm opens this list 'l:;auregfintonnff eis
e of people who are currently b
online. Michael Myers
Northern
= Steve Hannah
Tech Support Reeves
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PARTICIPATING IN
CONFERENCES AND CHAT ROOMS

Conferences and chat rooms allow people to hold active discussions
while they are online. Conversations in these areas are “live,”
rather than consisting of saved messages as in forums or e-mail.

In conferences and chat rooms, people communicate by typing and
sending messages to the conference window. When you join a
conference or chat in progress, you won'’t see the conversations that
took place before you joined. As the conversations continue,
however, you will see what other participants say and have an
opportunity to participate.

Conferences and chat rooms look and work identically, but there is
one basic difference. Conferences are public meeting places that are
set up by the service administrator and usually focus on a particular
topic. Chat rooms, on the other hand, are informal and can be
started at any time by anyone online. Chat rooms are basically
private—other people can join only if they know the name of the
chat room or if a participant invites them to join.

JOINING A CONFERENCE

60

Conferences can be represented by this icon, or by a custom
button or graphic on a service.
To enter a conference:

e  Double-click the conference icon or click the custom button or
graphic that represents the conference.

NS Sysop Chat

When you want to leave the conference, close the window by choosing
Close from the File menu.
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JOINING A CHAT ROOM
If you know the name of an active chat room, you may join it.

To join a chat room:

I Choose Join Chat... from the Users menu.

Cancel

2 Type the name of the chat room that you want to join, and click Join.

Reptile Chat

The chat room window opens. If there was no chat room by the name
that you entered, NovaTerm notifies you and creates one automatically.
When you want to leave the chat room, close the window by choosing
Close from the File menu.

CONTRIBUTING TO A CONFERENCE OR CHAT ROOM

When you join a conference or chat room, spend a few moments
reading the comments from other participants so that you know
what’s happening in the discussion. Once you’re acclimated, feel
free to jump in.
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To participate in a conference or chat room:

I Type your comments in the box at the top of the window.

Because people in a conference are reading many messages, keep each
message brief. If you have a lot to say, break it into several smaller
messages, so that people have a chance to read other messages too.

2 Click the arrow button below your comments.
Or,

Press the Return key.

The message you typed in the box appears in the conference window,
preceded by your screen name.

LISTING PARTICIPANTS IN THE CONFERENCE OR CHAT

As people contribute to the discussion, each person’s comments are
preceded by his or her screen name. Still, not everyone in the
conference or chat room is necessarily an active participant.
NovaTerm lets you see a list of everyone who is currently in the
conference or chat room.

To see a list of the people participating in the conference:

* Click Who.

Sl |===——————— NS Sysop Chat

LAUREN ANTONOFF : Hello

Users in conference :
ALEX HOPMANN
LAUREN ANTONOFF
MOEL

Ji

A list of the participants appears in the conference window.

INVITATIONS TO CONFERENCES AND CHAT ROOMS
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Any participant in a conference or chat room may invite you to join.
You may also invite people to join a conference or chat room in
which you are a participant.
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To invite others to join the conference:

I Click Invite in the conference or chat room window.

Online Users

Cyberdelic
dwilson

Jason Ehrlich
jmbarry

Michael Muyers
NOEL
Rob

NovaTerm opens a list of people who are currently online.

2 Click the name of the person to invite, and click OK.

The person that you selected is sent an invitation to join the conference.

To respond to an invitation:
* Click Chat to join the conference or chat room.
Or,

* If you prefer not to join, click Decline.

CREATING A NEW CHAT ROOM
If you want to have a private discussion or to start a discussion on a
new topic, you can create a new chat room. When you create a chat

room, you also get a few extra privileges like the ability to send a
notice to new participants or to expel a participant from the chat.
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To create a new chat room:

I Choose New Chat Room... from the Users menu.

Create Chat Room

2 Type a name for your chat room, and click Enter.

Reptile Chat

it
i
2 o

A chat room with that name is created and opened. If a chat room with
that name already exists, you will automatically join that chat room.

Once you create the room, you can invite people to join it, as
described above. If you want the chat room to focus on a specific
topic, you can also set up a special notice that people will see when
they enter the chat room.

To set up a notice for the chat room:

I Click Notice in the chat room window.
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Cancel

2 Type a brief notice and click OK.

Each participant will see this notice upon entering the chat room.

Because chat rooms are essentially private, the person who creates
the room has some control over who can participate in it. People
can join the chat room only if they know the name of the room, or if
they are invited by a participant. Also, if a user in a chat room
becomes disruptive, you can expel that person from the chat room.

To expel a participant from a chat room:

I Click Kick Out in the chat room window.

2 Type the screen name of the person to expel, and click OK,

The person is notified of being expelled, and will no longer be able to
view comments or participate in the chat room.

SENDING A BULLETIN

Bulletins are simple messages that appear in the Server Messages
window. You can send a bulletin to anyone who is presently online.
They’re a polite way to send a note without interrupting anyone.

To send a bulletin:

I Choose Send User Bulletin... from the Users menu.
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Online Users

s

dwilson
Jason Ehrlich
jmbarry

MNOEL
Rob
Tech Support Reeves

G i

| cancel |

NovaTerm opens a list of people who are currently online.

2 Click the name of the intended recipient, and click OK.

EJ Donovan just 1ogged off.
ALER HOPHANN: Give me a call later...

The bulletin shows up in the recipient's Server Messages window
following your name. (So remember to keep your bulletins brief.)
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CHAPTER NINE

USING THE
WEB BROWSER

In this chapter, you’ll learn about the World Wide Web, and how to use the
NovaTerm browser to open web pages.

= INTRODUCING THE
WORLD WIDE WEB
AND THE WEB BROWSER

The World Wide Web is a network of documents, or pages, on the
Internet that offer a wide variety of information. The pages that
comprise the web are created by individuals, companies,
government agencies, schools, clubs, and other organizations. They
cover just about every topic you can think of.

Most people need an account with an Internet provider to access the
Web, but NovaTerm lets you browse the Web by connecting to
NovaServer. Even if the service you connect to does not offer
Internet access, NovaServer lets the service create local pages for
its users.

Tips: NovaTerm uses a cache to save the pages that it has displayed so that
they can be opened faster. The original cache size is two megabytes, but you
can improve NovaTerm's performance by increasing its cache size. If your disk
space is limited, you can reduce the size of the cache. To change the cache
size, choose Preferences... from the File menu, and enter a new cache size in
the Cache Size field.

Many web pages contain a large amount of data, including graphics. To display
these pages, NovaTerm uses your computer's memory, including RAM
(random access memory) and virtual memory. If NovaTerm does not have
enough memory available, you will encounter problems. To find out how to
make more memory available, see “Increasing the Memory Available to
NovaTerm" in the Troubleshooting Appendix.
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OPENING HOTLINKS

68

Hotlinks are clickable areas that open pages or documents on the
local service or on the Internet when they are clicked. Each hotlink
opens a specific item. When you click a hotlink to a local or World
Wide Web page, the NovaTerm browser opens automatically.

Many services that publish local pages or offer access to the World
Wide Web have hotlinks in the text of their welcome window or in
buttons in their navigational menus. You may also find hotlinks in
forum posts, mail messages, or other documents on the service.

In text, hotlinks usually look like blue underlined words or phrases.
When you move the pointer over a hotlink in text, the arrow
changes into a hand. In menus, hotlinks look like a button or
graphic image. Until you click a button, it may be difficult to tell
if it’s a hotlink or not. Click it, and you’ll find out.

To open a hotlink:
*  Click the hotlink.

esNovra Software

The NovaTerm browser window opens, displaying the page that the
hotlink is linked to. Many pages also contain hotlinks to other pages.
Whenever you see a hotlink, you can click it to see the page that it is
linked to.

Note: Some large or complex pages may take a while to open. If you
want to stop NovaTerm from continuing to open the page once it has
started, click the Cancel button at the top of the browser window.
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CREATING HOTLINKS

If you want to open the browser and you can’t find a hotlink, you
can create a one yourself. To do so, you must know the network
address, or URL (Uniform Resource Locator), of the page that you
want the hotlink to open. For starters, you can create a hotlink to
ResNova’s site, NovaCentral. The URL is

http:/ /www.resnova.com/.

To create a hotlink and use it to open the browser:

5

Choose New Document from the File menu.

If you prefer, you can create hotlinks in a new mail message so that you
can send it to other people. To do so, choose Compose Mail from the
Messages menu instead. If you do create your hotlinks in a mail message,
make sure you save a copy or mail a copy to yourself.

e

Type a word or phrase that you want to hotlink.

If you want to create more than one hotlink, or if you want to include
other text in the document, complete all of the text, including the words
or phrases that you want hotlink, before creating the hotlinks.

Select the word or phrase that you want to hotlink.

Choose Make Hotlink... from the Messages menu.

http://www.resnova.com

Type the URL for the item that you want the hotlink to open.

Chapter 9: Using the Web Browser 69



6 Click Enter.

You can recognize the hotlink because the text is blue and underlined,
and, if you move the pointer over it, the arrow changes into a hand.

7 Click your new hotlink.

The NovaTerm browser window opens, displaying the page or document
that your hotlink is connected to...

Tip: Save the document with your new hotlink so that you can use it again
later. To do so, choose Save from the File menu. Use the dialog to name the
document and select a destination for it, then click Save.

OPENING PAGES USING URLS

Using hotlinks to jump from page to page, you may find all sorts of
interesting things. But if you want to open a specific page once the
browser is open, there is a quick and easy way. All you need is its

URL, and, of course, access privileges to open that page.

To open a specific page using its URL:
I Type a URL in the field at the top of the browser window.
2 Click Read.

Or,

Choose Read from the Messages menu.

Note: Remember, some pages contain a considerable amount of information
and may take a while to open. If you want to stop NovaTerm from continuing
to open the page once it has started, click the Cancel button at the top of the
browser window.

FLIPPING THROUGH
RECENTLY OPENED PAGES

70

When you open pages with the browser, NovaTerm records their
URLs in the URL History window.

To open the URL History window:

* Choose History Window from the Windows menu.
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URL History

http. /7% ffile/welcome. html
http:/ /www . resnova.com/
http:/ /www . apple.com/

The URL History window shows the URLs of the pages you open with
the browser, as well as the URLs of other items on the service that
NovaTerm has opened. (Every item on a NovaServer service has its own
URL that NovaTerm uses to open that item.)

If you want to open a URL that you see in the URL History
window, you can do so by copying it and pasting it into the browser.

To open a URL that is listed in the URL History window:
I Select the URL from the URL History window.
2 Choose Copy from the Edit menu.

3 Bring the browser to the front by clicking it or by choosing the name
of the currently open page from the Windows menu.

If the browser isn't already open, you can open it as described above.

4 Make sure that the URL in the field at the top of the window is selected,
and choose Paste from the Edit menu.

The URL copied from the URL History window appears in the field.

5 Click Read.
NovaTerm opens the URL.

The buttons in the browser window also make it easy to flip
through recently opened pages.

To open the previous page that you viewed:

*  Click the left arrow button at the top of the browser window.

To go back to the former page:

*  Click the right arrow button at the top of the browser window.
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APPENDIX

TROUBLESHOOTING

B In this appendix, you'll learn how to handle some problems that you may
encounter while using NovaTerm. If you are still unable to solve a problem,
please contact your service administrator.

GETTING CONNECTED

If your are not able to connect to a NovaServer system, this section
may help you solve the problem. If these suggestions don’t seem to
help, keep in mind that the service may not be accepting new
connections due to routine maintenance or because too many people
are currently connected. If the problem persists, however, contact
the service administrator.

CONNECTING WITH A MODEM

The suggestions below should remedy most problems that prevent
modems from connecting. After following each suggestion, try to
connect again. If the problem persists, go on to the next step.

To narrow down the problem:

You can eliminate some of steps by watching NovaTerm and
listening to your modem while you try to connect.

If NovaTerm says that it has established a connection, or if
you hear the modem dialing and another modem answering
(modems play a series of screechy tones when they answer),
NovaTerm is encountering problems after it reaches the
service, so start with step 9.

If you hear the modem dialing, but you don’t hear a modem
answer, NovaTerm is communicating with your modem but it
may not be reaching the service, so start with step 6.

If you don’t even hear your modem dial, NovaTerm may not
be communicating with your modem, so start with step 1.
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To tackle a modem problem:

Check the modem cable.

If you have an external modem (one that's outside of your computer),
make sure that the cable is properly connected to the computer and to
the modem. Don't worry about this if you have an internal modem.

Make sure that the NovaTerm connection type is set to Modem.

To check, click Setup in the NovaTerm opening window. Modem should
be selected in the Connection Type pop-up menu.

Make sure that you have the correct modem port selected.

Most computers have more than one port that you can connect your
modem to. If you have an external modem, start by looking at your
computer to see which port the modem cable is plugged into. Then,

choose Modem Settings... from the File menu and make sure that port is

the one selected in the Port pop-up menu. If you have an internal
modem, make sure that the internal modem is selected in the pop-up
menu.

If you have another port that your modem can connect to, try

switching the cable to that port and changing the NovaTerm port setting

accordingly.

This will help eliminate a problem with the port that your modem was
originally connected to. On a Macintosh, you can connect your modem
to the printer port (or other serial port) On a PC, try another
communications port, preferably COM| or COM2. (Other COM ports
may be less reliable.)

Make sure that no other program is using the modem.

If you have any other telecommunications programs open, quit or exit
them to ensure that they are not using the modem.

Make sure that the modem is connected to a working phone line.

Many modems have two places for you to connect a phone cord—one
for the phone line coming from the wall, and the other to plug in a

telephone. Make sure that the phone line is plugged into the right one,
usually the one called “Line” or “In,”" as opposed to “Phone” or “"Out.”

Also, make sure that the phone cord is connected to a working phone
jack. You can test the line by sticking a telephone on it, or by plugging a
phone into the “Phone” or “Out” connector, if your modem has one.

Check the service phone number.

Click Setup in the NovaTerm opening window and check the number in
the Access Number field. Make sure that you include the correct area
code, if one is necessary.

NovaTerm 4.0 User Guide



If you were instructed to connect through a provider, make sure that this
setting is checked and that the provider information is correct. (If you
were not instructed to use the Connect Through Provider setting, make
sure that this box is not checked.)

Check the dialing prefix.

Choose Modem Settings... from the File menu. If you need to dial a
prefix to get an outside line, make sure that the For Outside Line Dial
box is checked and that the correct prefix is entered in the adjacent field.
If you don't need to dial a prefix, this box should not be checked.

If you know another phone number for the service, try connecting to
that phone line instead.

The modem connected to the first line may not be answering properly or
may not work well with the brand of modem that you are using,

Turn the modem off and on again.

Modems have interal settings that, when improperly configured, can
prevent the modem from connecting. Turning the modem off resets
these settings to their default values. It's also a good way to make sure
that the modem is actually tumed on and getting power.

External modems (ones that are outside of your computer) have buttons
or switches that let you tumn them on or off. Internal modems usually
have software controls to tum them on and off, but you can also reset
them by turning your computer off for a few seconds.

Manually initialize the modem.

Before NovaTerm dials your modem, it sends a string of characters to
your modem to enable certain features. This is known as initializing a
modem. NovaTerm tries to automatically initialize your modem, but if
you continue to have problems, you may need to manually initialize it by
entering a different initialization string.

A few strings that may successfully initialize your modem are “ATZ",
"AT&F", or "AT&FI".

To enter an initialization string, choose Modem Settings... from the
NovaTerm File menu and click the Custom Modem Init box to check it.
Then, type the initialization string in the adjacent field.

Try each of the three strings suggested above, one at a time. After
entering each string, try to connect.

If the modem connection continues to fail, technical support from your
modem manufacturer should be able to provide you with an initialization
string specifically designed for your modem. When you contact technical
support, inform them that the initialization string should include the
commands to enable error correction and hardware handshaking.
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12 Restart your computer.

Once some types of modem problems arise, you can only remedy them
by restarting your computer. To do so, choose Restart from the Special
menu (on a Macintosh) or from the File menu (in the Windows Program
Manager.)

I3 Make sure that you have the right type of modem cable.

To connect properly, any modem faster than 2400 baud requires a
hardware handshaking cable. Most high speed modems come with this
type of cable, but if your modem continues to have problem, you should
make sure that you are using the proper cable.

1 4 Have your phone line checked for excess line noise.

Some phone lines, especially older or poorly shielded lines, are noisier
than others. This background noise can prevent modems from connecting
or transferring information properly. Sometimes you can hear line noise
when you hook the line up to a telephone, but lower levels of noise may
still interfere with your connection. If you suspect this problem, try to test
your modem on another phone line. If you can connect over the other
line, you should contact the telephone company about reducing the line
noise.

CONNECTING OVER AN APPLETALK NETWORK

76

Remember, to connect to NovaServer over an AppleTalk network,
your computer must be on the same AppleTalk network (or
internetwork) as the service that you want to connect to. If you are
unable to connect to NovaServer over an AppleTalk network, the
suggestions below should help you resolve most common problems.
After following each suggestion, try to connect again. If the problem
persists, go on to the next step. If none of the suggestions work, ask
your network administrator to investigate other network problems.

To narrow down the problem:

You can eliminate a couple of steps by testing your network
connection first. Try to use another network service, such as printing
or accessing another server on the network.

* If you can successfully connect to another service on the
AppleTalk network, such as a printer or file server, but are
unable to connect to NovaServer, start with step 3.

* If you are not able to connect to anything over the network,
start with step 1.
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To tackle the problem:

I Check the network cable and connector.
. Make sure that the network cable is properly connected to your
computer. If you use a network connector that attaches to the back of the
= computer, make sure that it is securely connected too. If you have
another network connector, you might try using that connector instead.
—

2 Make sure that AppleTalk is turned on in the Chooser.

On most Macintosh computers, you can open the Chooser by choosing

Chooser from your 8 menu. Once the Chooser is open, click the

g AppleTalk icon on the left. Then, make sure that the Active button (on
the right) is selected. (If you're not sure if Active is selected, click it to be

s safe.)

3 Make sure that the NovaTerm connection type is set to AppleTalk.

To check, click Setup in the NovaTerm opening window. AppleTalk
should be selected in the Connection Type pop-up menu.

4 Make sure that correct AppleTalk zone is selected.

If you are using an AppleTalk network with more than one zone, make

sure that you know which zone the NovaServer service is in. To check

the zone setting, click Setup in the NovaTerm opening window. The
service's zone should be selected in the Zone Name pop-up menu.

5 If there is more than one NovaServer service in the zone that you
selected, you need specify the name of the service.

R The service's official name may be different from the name that it is
commonly known by or the name that appears in the Services menu. To
find out the official name, ask your service administrator. Once you
confirm the name, click Setup in the NovaTerm opening window and type
the service name in the Connect to Service field.

6 Restart your computer by choosing Restart from the Special menu.

Once some types of network problems arise, you can only remedy them
by restarting your computer. To do so, choose Restart from the Special
menu (on a Macintosh) or from the File menu (in the Windows Program
Manager.)
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INCREASING THE MEMORY
AVAILABLE TO NOVATERM

78

When NovaTerm is running, it uses a type of memory called RAM
(random access memory.) As you open menus and documents on the
service, NovaTerm stores this information in its memory. When you
close these items, NovaTerm removes them from memory. Still, the
longer you stay online and the more NovaTerm does at once, the
more memory NovaTerm uses. Documents that display pictures,
including web pages, can use especially large amounts of memory.

When NovaTerm does not have enough available memory, you may
encounter problems. Pictures may not display properly, or
NovaTerm may just stop working. If you are experiencing these
types of problems, you may be able to solve them by making more
memory available to NovaTerm as described below. After followin
each of the suggestions, try using NovaTerm again. If the problem
persists, go on to the next step.

To make more memory available to NovaTerm:

I Close NovaTerm by choosing Quit or Exit from the File menu,
and restart your computer by choosing Restart from the Special menu
(on a Macintosh) or from the File menu (in the Windows Program
Manager.)

2 While you are using NovaTerm, try to run as few other programs on
your computer as possible.

If other programs are open, quit or exit them before opening NovaTerm.
If you use a lot of programs that run in the background, such as Macintosh
System Extensions, try disabling some and restarting your computer.

3 If you are using a Macintosh, you may need to allocate more memory
to the NovaTerm application. (This is not necessary for Windows
users.) To do so:

a Make sure that NovaTerm is not open. If it is, choose Quit from
the File menu.

b Locate the NovaTerm 4.0 icon on your disk and click it once
to select it.

¢ Choose Get Info from the Macintosh File menu.
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E[J=== NovaTerm 4.0 Info

MovaTerm 4.0

Kind : application program
Size: 626K on disk (702,151 bytes used)

Yhere : Hard Disk : NovaTerm 4.0 Folder :

Created: Tue, Aug 8, 1995, 545 PM
Modified: Wed, Aug 9, 1995, 7:02 PM
Yersion: NovaTerm™ 4.01 ©1995 by
ResMNova Software, Inc.
Comments:

~Memory Requirements ...
| Suggested size: 4000

K
i Minimum size: K
[JLocked i Preferredsize: [4000 |K

The NovaTerm 4.0 Info window shows additional information
about NovaTerm. The Memory Requirements area in the bottom
right and lets you change the memory allocation.

Make sure that the Minimum size is at least equal to the Suggested
size and increase the Preferred size by 1000 — 3000 K.

Your Macintosh uses the Minimum and Preferred size values to
allocate memory to NovaTerm. In order to open NovaTerm, your
Macintosh must have at least the Minimum size worth of available
memory. If more memory is available, it will allocate additional
memory to NovaTerm, up to the Preferred size.

In general, you should allocate as much memory to NovaTerm as
you can afford. Keep in mind, however, that allocating memory to
NovaTerm reduces the memory that will be available to other
programs while NovaTerm is open.

To change the current allocations for the Minimum or Preferred
size, select the current value and type a new number. If you can not
select the current value, NovaTerm may locked or open. If the
Locked checkbox to the right of the Memory Requirements area is
checked, click it once to unlock NovaTerm.

Close the NovaTerm 4.0 Info window by choosing Close Window
from the File menu.
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Enable or increase your computer’s virtual memory.

Computers can use a portion of your hard disk as memory. This type of
memory is known as “virtual memory" and can be used like RAM. To
enable virtual memory on a Macintosh, open the Memory control panel
and click virtual memory On button. You can also use this control panel
to increase the amount of virtual memory that your Macintosh uses. To
increase the amount of virtual memory used on a PC, adjust the settings
in the System control panel.

Upgrade the amount of RAM that is installed in your computer.

The suggestions above should make more memory available to
NovaTerm. Still, some computers do not have enough RAM installed to
use NovaTerm comfortably, especially to connect to larger services. For
information on RAM upgrades, contact your computer dealer.
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notices, in chat rooms 64-65
NovaCentral 69

NovaLink Professional
See NovaServer 57

NovaServer 15
connecting to 7-14

NovaTerm 4.0.sea 2

NovaTerm client

for Macintosh
Installation 2-3
NovaTerm Resources 3
system requirements 1

for Windows
installation 3-5
NOVATERM.CFG 3
NOVATERM.EXE 3
system requirements 1

NovaTerm Resources 3
NOVATERM.CFG 3
NOVATERM.EXE 3
NovaView menus 16
NTINSTAL.EXE 3, 4

O

off-line e-mail 37-38

online help, using 17-18
online users, listing 59
Open Mailbox 40-41
Outgoing Mail folder 37-38

P
pages, World Wide Web 67-71

password
changing 21
defining 13
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saving 11
security 11

people

See users 59

phone number
dialing prefix 12
entering 10

pictures in message bodies 32-33
polls 23-24
Port pop-up menu 11

posting
files to libraries 48-49
messages to forums 29-31

Power Macintosh
support 1
version, installation 2-3

preferences 67
Auto-Open Receive Files 47
cache size 67
Include Message With Reply 28, 43
language 22
receive folder 51-52

previewing files before download 47
printing 20

private mail
limitations on privacy 35
See also electronic mail 35

progress bar
file transfers 50-51
Server Messages 19

Provider Account 10

Provider Password 10

providers, connecting through 10
public posting 29-31

Q

queuing file transfers 50, 51
quitting NovaTerm 14
quoted text in replies 28, 43

R

RAM
increasing available 78-80
requirements 1

Rept 36

Index

reading
electronic mail 40-41
messages 26-27
next or previous in thread 29
next or previous thread 29

receive folder
“n” suffix 50
defining 51-52

Receives
See receive folder 52
See also file attachments 27

receiving files 27, 42, 43

redialing modem, automatically 12
registering a new account 12-13
release of files to libraries 49
Reload 46

Remove (file transfers) 51

replying : .
to electronic mail 43
to message posts 28

resnova.com 69
resuming interrupted transfers 50
Return Receipt 36

S

Save Service Password 11
scanning for new posts 53-55

screen names 10, 13

searching
AppleSearch servers 55-57
file libraries 46
for new posts 53-55
WALIS servers 55-57

security, password 11
Send Outgoing Mail 37-38

sending
bulletins 65-66
electronic mail 35-39
file attachments 39-40

serial port, selecting 11

Server Messages
receiving bulletins 66

Server Messages window 19

servers

AppleSearch, searching 55-57
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se

se

WAIS, searching 55-57

rvice files

creating 7-8

defined 5

installing 5-6
pre-configured 5-6, 8, 10-14
selecting 7-8, 14

updating 5

rvices

connecting to 7-14
creating a service file 7-8
network address 10
phone number 10

pre-configured service files 5-6, 8-14

selecting a service file 7-8, 14
Services folder 6
Services menu 6, 7-8, 14

Services folder 6

Services menu 6, 7-8, 14
SETUP.EXE 4

Setup... 9-11

Skip (file transfers) 51

SO

SO

SO

ftware installation 1-6

rting

electronic mail 41
file libraries 45-46, 56
message forums 26
NewScan results 54
subscription list 55

unds 15

styled text

in HTML messages 34
in messages 31-32
Normal style 32

subscription list

explained 54
sorting 55

surveys 15

o 4
i &

! 3

sops
See administrators 17

stem requirements 1

TCP/IP networks

connecting over 9-11
connection settings 10

Telnet 22-23
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text
using different colors 31, 32
using different fonts 31-32
using styles 32

threading, in message forums 26
time online 19

troubleshooting
AppleTalk 76-77
memory related problems 78-80
modems 73

troubleshooting modems 76

U

underlined text, using 32
unsubscribing 54-55
updating service files, automatic 5

uploading
defined 45
file transfers 49-52
files to libraries 48-49

URL
defined 69

URLs 33
History window 70, 71
NovaCentral 69
opening 69

users
currently online, listing 59
in chat or conference 62

A"

validation 13

virtual memory 80

volume, adjusting modem 11
voting 23-24

W
WANS, connecting over 9-11

welcome window 16

who
in chats and conferences 62
is currently online 59

wide area networks
See WANSs 9

WIN32S
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installation 4-5

required for Windows 3.1 1
windows

managing multiple 21

Server Messages 19

URL History 70-71
Windows system requirements 1
WINSOCK 10

World Wide Web
browser 67-71
caching pages 67
hotlinks to 33-34, 70
HTML 34

WWW
See World Wide Web

Z
zone, AppleTalk 11

Index
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